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CHAPTER – I
Structural Analysis – Basic Concepts ( A Revision ) 

This Chapter covers:
Ø Basic definitions 
Ø What is Structural Analysis? 
Ø Methods of Analysis 
Ø Need for Computer method of Analysis. 
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Structures are defined as a frame work that carries external loads. A structure, in 
general, is composed of interconnected members, connected by rigid joins or frictional 
hinges. 

DEFINITIONS
Beam 

Generally, a beam is a structural horizontal member used to carry vertical loads . 
Beams are provided to support floor slabs , secondary beams , walls, stairs etc.

Types of Beam 
According to the supports provided they are classified as : 

1. Simply supported beam 
A beam having its two ends freely resting 

on masonry walls or pillars is called as simply 
supported Beam.  

2. Cantilever beam 
A beam with one end rigidly fixed and the other 

end free (i.e . not supported ) is called cantilever beam . 
3. Propped cantilever beam 
A beam with one end rigidly fixed and the other 

end resting on masonry walls or pillars is called 
propped cantilever beam.

4. Over hanging beam 
A beam which is simply supported at two points 

and having projections at once or both ends beyond the 
supports is called an overhanging beam. 

5. Continuous beam 
A beam which has more than two supports 

is called continuous beam. 
6. Fixed beam 
A beam with both of its ends rigidly fixed or built-in into the supporting walls or

columns is called fixed beam. 
7. Frames 
They are made up of beams and columns. 

Equilibrium Equations: 
Statics offers three conditions of equilibrium for co-planner force system : 
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åH = 0
åV = 0
åM = 0

Classification of structures:
Structures can be classified into following two types:
Statically Determinate Structures 

If the number of reactions is equal to the number of available static conditions, 
then the reactions and the internal forces can be determined using the principle of 
statics alone . So these types of structures are called statically Determinate Structures 
.Ex. Simply supported beam, Cantilever beam, Propped cantilever. 

Statically Indeterminate Structures
If the number of reaction components is more than the number of available static 

equations, the reactions and the internal forces cannot be determined using the 
principle of statics alone. We require additional conditions to determine the reactions in 
the structure. These types of structures are called Statically Indeterminate structures. Ex. 
Continuous beams fixed beams etc. 

Types of Supports:
Depending on their functions the supports of beams are classified as follows:-

1. Simply support:
   It is one which has only a vertical reaction. It allows horizontal movement or
   rotation. Ex. Masonry Walls.  

2. Roller support:
It is similar to the simply support. It offers only a vertical reaction. Rollers are 

provided to facilitate free horizontal movement. Ex. Roller bearings for trusses.
3. Hinged support:

It is also called pinned support . It 
offers both vertical and horizontal 
reaction, but it allows rotation.

4. Fixed support:
It offers vertical, horizontal reaction 

& moment. Members are restrained 
against any movement. Members are 
restrained against any movement or 
rotation. Ex. Built in Beams, welded 
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joints.
Effective Span:

Centre –to – distance between the supports is called effective span. 
      Note: - In STAAD PRO, Nodes are constructed using this effective span only .

TYPES OF LOADS ON BEAMS

Pin jointed frame
A pin jointed frame is a structural framework consisting of members like angles, 

channel, pipes ext. Jointed together at their ends by rivets or bolts, to from the required 
shape and to carry the external load.

A truss is a pin jointed frame when it is used to support the roof. Pin-
jointed frames are also called as girders when it is used as a beam in bridges etc. It may 
be called as tower when it is used as mast.
Loadings in pin joined frames:

The loads are generally applied at the joints (called nodes) of the frame and hence its 
constituent members are always subjected to axial forces and never to bending moment 
or shear forces. 
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The axial forces may be either compression or tension forces. Sometimes, the same 
member may be subjected to different nature of forces under different loading 
conditions. 

Pin – jointed frames broadly classified into two types:
1. Perfect frames   and 
2. Imperfect frames. 

A frame which has sufficient number of number members, to keep it in equilibrium 
without any change in its shape under the action of external loads, is called a perfect 
frame. 

In short, when a structure satisfies the following equation it is called perfect frames,
otherwise it is Imperfect frames. 

N =2j – 3
Here,
   n = number of members in the frame. 
   J = number of joints or nodes in the frame. 
Also, frames are classified as follows depending upon the determinacy. A frame 

which could be analyzed completely using three static equations (åH =0; åV =0 ; åM=0) 
is called statically Determinate structure . 

A frame which could not be analyzed using the three static equations ( åH =0; åV =0 
; åM=0) alone is called statically Indeterminate structure.

Analysis of Frames:
The perfect frames are analyzed by the following methods, conventionally:

1. Method of joints. 
2. Method of sections 
3. Graphical method. 

Others types of frames like imperfect frames are analyzed using advanced methods. 
What is Analysis or Structural Analysis? 

Structural Analysis is the determination of the internal forces in the members of 
the structure due to the external loads acting on it . The external loads may act at the 
joints or on the members.

The internal forces that we are finding out are called axial forces, shear forces,
bending moment or torque. 
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The structures also are stable apart from its strength to withstand the action of 
external loads. For that, it should be supported properly and maintain a stable 
equilibrium. The supports may be of roller, hinged or fixed support. 

These supports exert external reactions. If these reactions are determined, then the 
internal forces can be found out and this process is called as analysis of structures or 
structural Analysis. 

Methods of Analysis
Statically determinate structures can be easily resolved, by calculating the 

summation of forces in both the directions. 
But, statically indeterminate structures cannot be solved simply by having statics 

equations alone. It needs extra reactions or formulas to solve the structure. These 
structures can be analyzed through any of the following methods:
1. Moment area method – for propped cantilevers and fixed beams. 
2. Three moment equation – for continuous beams. 
3. Moment distribution method -  for continuous beams and frames 
4. Slope deflection method - for continuous beams and frames 
5. Method of column analogy – for frames  
6. Method of consistent deformation – for trusses. 
7. Substitute frame method, cantilever method – 3D frames.

Need for Computer Method of Analysis
One can feel the toughness and consider the time factor, for solving 

indeterminate problems using these methods. He has to keep the entire formulas,
calculations, code requirements etc. in figure tip, to analyze and design a structure. 

Not only that, you have to see accuracy in calculations and have to keep in mind 
all the methods & procedure. Also you cannot see the results in depth in manual 
calculations.

To overcome these difficulties, computer method of solving the problems 
emerged. Following are advantages of computer aided analysis & design. 

Ø Analysis and design can be done within a fraction of second 
Ø Once constructed the structure, it can be verified for many conditions. 
Ø Any type of structure can be resolved. 
Ø Very less manual calculations and formula workout. 
Ø Accurate and in depth results.
Ø Graphical and printout results can be taken, etc.
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CHAPTER – II
INTRODUCTION TO STAAD PRO

This Chapter Covers:-
v History of Software.
v METHO OF ANALYSIS IN STAAD
v STAAD PROGRAM FLOW CHART
v STARING STAAD PRO
v INTRODUCING  STAAD PRO SCREEN
v OVERALL PROCEDURE IN WORKING WITH STAAD
v SETTING DEFAULT CONFIGURATION
v STAAD BASIC DEFINATIONS
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About STAAD

STAAD Pro V8i is the most popular structural engineering software. The 
ultimate power tool for Computerized Structural Engineering. Staad Pro is the use of 
computer technology to aid in the Structural design of Civil Structures. Staad originally 
meant Structural Analysis & Design. 

Staad pro is the product for 3D model generation, analysis and multi-material design. It 
has an intuitive, user-friendly GUI, visualization tools, powerful analysis and design 
facilities and seamless integration to several other modelling and design software 
products.

The software is fully compatible with all Windows operating systems but is 
optimized for Windows XP. See the new STAAD Pro V8i from the comfort of your own 
home or office in a FREE interactive online demonstration or watch some online 
tutorials at your own leisure.

STAAD Pro has been the choice of design professionals around the world for 
their specific analysis needs

Who Uses

Professions

· Structural engineers
· Consulting engineers/engineering consultants

Firms 

· Structural engineering
· Structural consultant
· Multi-discipline E/A and A/E
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· Departments in construction companies, owner/operators, and government 
agencies

Staad Pro was born giant. It was mixture of the expertise of two long experienced 
companies.

STAAD PRO introduced a really good-looking interface which actually utilized 
all the exceptional features of Windows XP/7/8/Linux (Each STAAD PRO was 
working respectively under the windows available at the time of releasing the 
software to the markets).

Staad Pro with new features surpassed its predecessors & compotators with its 
data sharing capacities with other major software like AutoCAD & Ms Excel.

The results generation was yet a new feature that you can depend on STAAD Pro 
to do for you, now, STAAD Pro can generate handsome reports of the inputs and the
outputs with the usage of graphical results embedded within, which can be 
considered as final document presented to the client.

The Concrete & Steel design were among the things that undergone a face lift , 
specifically the concrete design as Bentley created a new module specially to tackle 
this issue. This new module Is easy , and straight forward procedure making the 
concrete design and results generation a matter of seconds ahead of the user.
History

In the Olden Periods, All the Structural calculations to be done by manually. In 
Early 80’s Some of the Private Structural organizations develop some structural 
programs. Engineers from that organization frame organization Research Engineers 
International Yorba Linda, CA.

Later Research Engineers International develops STAAD Pro (2000). Initially this 
product was launches as rental product (Staad –III). These products are used for 
educational purposes only. From Staad –IV, Staad is launched as Commercial Products. 
In late 2005, Research Engineer International was bought by Bentley Systems. 

The commercial version STAAD Pro is one of the most widely used structural 
analysis and design software. It supports several steel, concrete and timber design 
codes.
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It can make use of various forms of analysis from the traditional 1st order static 
analysis, 2nd order p-delta analysis, geometric non linear analysis or a buckling
analysis. It can also make use of various forms of dynamic analysis from modal 
extraction to time history and response spectrum analysis.

In recent years it has become part of integrated structural analysis and design 
solutions mainly using an exposed API called OpenSTAAD to access and drive the 
program using an VB macro system included in the application or other by including 
OpenSTAAD functionality in applications that themselves include suitable 
programmable macro systems. Additionally STAAD Pro has added direct links to 
applications such as RAM Connection and STAAD.Foundation to provide engineers 
working with those applications which handle design post processing not handled by 
STAAD Pro itself. Another form of integration supported by STAAD Pro is the analysis 
schema of the CIMsteel Integration Standard, version 2 commonly known as CIS/2 and 
used by a number modeling and analysis applications.

Clients
A. Entergy, Bechtel Power
B. ProtoPower
C. Altran Corporation
D. BE & K in Alabama 
E. Kellogg Brown and Root

Method of Analysis in STAAD
One of the most famous analysis methods to analyze continuous beam is “Moment 

Distribution Method”, which is based on the concept of transferring the loads on the 
beams to the supports at their ends.

Each support will take portion of the load according to its K; k is the stiffness 
factor, which equals EI/L. As you can see E, & L is constant as per span, the only 
variable here is I; moment of inertia. I depend on the cross section of the member. So if 
you on the cross section of the member. So if you want to use this analysis method, you 
have to assume a cross section for the spans of continuous beam.

If you want to use this method to analyze a simple frame, it will work but if you 
go for simple 3d frame this method proves to be very complicated. Hence a new more 
sophisticated method emerged, which depends fully on  matrices this method is called 
“Stiffness Matrix Method”, the  main formula of this method is ,
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(P)= (K) x (_)
The 3 matrices are as follows, 
   (P) - is the force matrix, which includes the forces acting on the whole structure, 

and the reactions at the supports. This Matrix is partially known as “Acting 
force” on the structures is already known from the different codes, like Dead 
Load, Live Load, Wind load, etc.., but reactions are unknown.

  (K) – is the stiffness factor matrix K-EI/L, and all of these data either assured known 
or assumed. So this matrix fully known

  (_) – is the displacement matrix. The displacement of supports are either zeros 
(fixed supports) or partially zeros (other supports), but the displacements of 
other nodes are unknown. So this matrix is partially known.

With this three matrices presented as discussed above , the  method  will solve the 
system with ordinary matrix methods to get the unknowns. If we solved for the 
unknown, the reactions will be known, hence shear & moment diagrams  can be 
generated , and the displacement  and deflection shapes  can be generated .

This method is very hard to be calculated by hand as it needs more time than 
other methods, so it was not concentrated up until the emergence of  computers. 
Computer program will do tedious & lengthy procedures to solve for this system of 
matrices, therefore structural software adopted it as the method of analysis. Staad was 
one of the first to do that.

Overall procedure in working WITH STAAD Pro
v Preparing the input file 
v Analyze/design the Program
v Reading the results and verify them

Preparing the Input Fil
Modeling mode is where we can prepare input file. It is the first step in working 

in Staad pro. Herewith we will describe our structures. i.e.., the geometry, the cross 
sections, the material and geometric constants , the support conditions & finally the 
loading system.

Analyzing & design in the program

Modeling Mode

Creating a structure

and giving     

Parameters

Analyzing & Design

Errors are checked.

Performing analysis

& Design

Post Processing Mode

Reading Results

& Taking reports
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VIEWING RESULTS

RUN ANALYSIS

SPECIFY ANALYSIS TYPE

GIVING LOADS

INPUT CONTANTS &SUPPORTS

GIVING PROPERTIES

CONSTRUCT GEOMENTRY

CREATING NEW FILE 

CONCRETE DESIGN STEEL DESIGN

After preparing the input file, next is to run the program. STAAD Pro analysis 
and design engine will start reading input file from left to right & from top to 
bottom.

The engine will mainly check for two things:
v Making sure that the user used the syntax of STAAD Pro commands, or else the 

engine will produce an error message.
v Making sure that all the data needed to form a stable structure exists in the input 

file, or else the engine will produce an error message.

If this two things are correct, STAAD will take values mentioned in the input file 
(without verification) & produce the output files.

Reading the results& verify them
VIEWING After reading and verifying 

your results you may decide to go back to your 
Modeling mode to alter your input file , for either 
to correct the input file , or to change some values 
to examine different results. The input file always 
has extension is “.std”

STAAD Program flow chart
Before proceeding further, first we have to 

Understand the flow chart of how STAAD Program 
Flows (or this is the Order to build 

up an input file).
The Procedure will enable us for

· Put each step in its right position, not before, and not after.
· Make sure that all of the STAAD Pro 

Commands are present in the input file and avoid error messages.
This chapter deals with two part, How to create New File, & Construction of 

Geometry** (or) Structure of a Problem
(**-Geometry is the Skeleton of your Structure, i.e.. it is the arrangement of 

members(beams & columns) and the plates(slabs, walls & foundations)
(or)
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(A structure is an assembly of individual components such as beams , columns ,
slabs , plates etc.)

Basic STAAD Definitions
Nodes (or) Joints

Node means a stiffed joint with 6 reactions in STAAD pro. It is located at each end of 
beam, and each corner of plate. First step in construction of Geometry is building up of 
Nodes. Each node has Node Number and XYZ Co-ordinate in space.

Beam (or) Member

Beam in STAAD Pro means any member in the structure. It can be beam column 
,bracing member Or Truss Member .Beams are actually defined based on Nodes at their 
Ends. Each Beam has a Beam Number & The Node number at its ends.

For Example, if we want to draw a member of 10 M length following is the Input,
Joint Coordinates
1 0 0 0; 2 10 0 0;
Member Incidence
1 1 2
In joint co-ordinates  

Command 1 is Node no 
First 0 defines x co-ordinate 
Second 0 defines Y Co-ordinate 
Third 0 defines Z Co-ordinate

In the 2nd Node
Command 2 is Node no 
First 10 defines x co-ordinate 
Second 0 defines Y Co-ordinate 
Third 0 defines Z Co-ordinate

Plate (or) Element

Plate in STAAD means a thin shell with multi-nodded shape starting from 3 
nodes. It can be of any things like slab, wall, or raft foundation. Each plate will have 
Plate number and Node numbers at each end of it.

Ex:-
Example:-
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Element incidences
1 1 2 3 4

1-Plate no
1,2,3,4- Node no

Surfaces

With the new Surface type of entity, the burden of meshing is shifted from the 
user to the program to some degree. The entire wall or slab is hence represented by just 
a few "Surface" entities, instead of hundreds of elements. When the program goes 
through the analysis phase, it will subdivide the surface into elements by itself. The user 
does not have to instruct the program in what manner to carry out the meshing.

Co-ordinate Systems

There are two 
types of co-ordinate 
systems in STAAD. 
They are used to build 
the model and to define 
the loadings. The Global co-ordinate system is a fixed 
co-ordinate system in space, which is used utilized to 
specify the overall geometry & loading pattern of the 
surface. A local co-ordinate system is related with 
each member or element.

The co-ordinate system is a rectangular co-
ordinate system (X, Y and Z) which follows the 
orthogonal right hand rule. This co-ordinate may be 

used to define the  joint co-ordinates and load 
directions. The translational degrees of 
freedom are denoted by u1 , u2 , u3 and the 
rotational degrees of freedom are denoted  by 
u4, u5 & u6.
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Local Co-ordinate systems

A local co-ordinate systems is associated with each member. 
GX,GY,GZ-> Global Axes
X,Y,Z -> Local Area

The following figure shows local axis 
system (s) for various shapes that are used 
in the analysis .
Local axis for different cross sections:
Staring Staad 

To start STAAD Pro, the following steps 
to be followed,

Ø Go to Start/All Programs/STAAD 
Pro 8i/STAAD Pro

Ø Double click the STAAD 
Short cut icon available in 
the Desktop

After double clicking, Staad 
Initial Screen appears, 
various parts to be 
explained as follows,

1. Recent Project
2. Project tab

3. Tutorials
4. License Config
5. Preview area

6. Menu Bar
7. Title bar
8. Staad online
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1. Recent Tab:- This tab is open recent project  from the list. Select project to open 

2. Project Tab:-This tab is used to access the project details 

New Project:- This tab is used to create new project.

Open Project:-This tab is used to open existing project.
Open Project wise:-This tab is used to group multiple projects.

Configuration:- Sets default configuration for STAAD.

3. Tutorials:- this tab is used get help (offline(or) online.

4. License Tab:-this tab is used to configure License code to analysis.

5. Preview Tab:- This tab is used to get project preview

Configure:-

The Configure option is available only when there is no 
file open in STAAD. The Configure dialog box can get 
from following ways (shown in the figure). 

Ø From the File menu, select Configure option.
Ø From the Project tab, click Configuration option.

From any of the above, the following dialog appears, 
used to get project preview

Base Unit

There are two base unit systems in the program which 
control the units (length, force, temperature, etc.) in 
which, values, specifically results and other information presented in the tables and 
reports, are displayed in. 

The base unit system also dictates what type of default values the program will 
use when attributes such as Modulus of Elasticity, Density, etc., are assigned based on 
material types – Steel, Concrete, Aluminium – selected from the program’s library 
(Please refer to Section 5 of the STAAD Technical Reference Manual for details). 
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These two unit systems are English (Foot, Pound, etc.) and Metric (KN, Meter, 
etc.)If you recall, one of the choices made at the time of installing STAAD Pro is this 
base unit system setting. That choice will serve as the default until we specifically 
change it using this facility.

Background Colour

The drawing window can be set to have either a white background colour or a 
black background colour. Doing so will also set some default colours in which beams, 
plates and solids are drawn. 

For example, a white background is accompanied by black lines for drawing 
beams. The user may change the colours of drawing beams, plates and solids through 
the facilities of the View | Options menu.

Steel Table

When an existing STAAD model is opened, the program reads the contents of 
the file, and checks the validity of data in that file. One of those data items validated is 
names of sections assigned from steel tables. Since steel sections are country-specific, 
such as British, German, etc., the program needs to know the country or organization 
whose steel table is the underlying database for validating the sections being read in 
from the file. Normally, the input file contains the name of the database as part of the 
member property command. In the absence of an explicit name, STAAD uses a default. 
That default is set using this facility.

STAAD Default Design Codes

STAAD supports several major international Design Codes. You may purchase 
and install one or more of those Design Codes. By default, STAAD always comes with 
one Design Code, depending on the country where you purchased the software. If you 
have purchased and installed more than one design code, this is one of the places from 
where you can set the default, or choose another. 

Though all the design codes are installed, only the design codes you have 
purchased are supported by the security device (hardware lock or license manager). 
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The installation program will ask you to select one of these as the default code. The 
default design code is the one selected when the STAAD command file does not contain 
any design code specification.

Please note that you may not use more than one Design Code in one single run, 
even if the Input Command File has more than one CODE command. Also note the 
Design Code specified by the STAAD Design Code tab must match that specified in the 
Input Command File.

Input File Format

Select whether joint coordinates, member, plate and solid incidences will be 
written one per input line or multiple per input line. Write Expanded List instructs the 
program to write out joint, member or element numbers individually, for example: 1 2 3 
4 5 instead of 1 TO 5 and consequently, creates voluminous input.

Working Directory:- Select the default folder to store STAAD files. Default folder is 
“C:\Users\dell\AppData\Local\Temp\”. User can choose his folder.

Global axis:- Select the axis whether LOCAL (or) GLOBAL. By default Global axis 
system to be adopted.
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STAAD 
Modeling
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CHAPTER – III
INTRODUCTION TO STAAD PRO

This Chapter Covers:-
v Creating new project.
v Co-ordinate systems
v Creating Structure using

o structural wizard
o snap /grid node
o editor /commands
o OVERALL PROCEDURE IN WORKING WITH STAAD
o Using excel work books.
o Using dxf import

v Using labels
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Staring New Project:-

Creating new project in STAAD Pro can 
be done in the following ways,

Ø From the File menu, select new
option.

Ø From the File Toolbar, Click New
icon.(Project Screen)

Ø From the Project tab, click New 
Project option.

From any of the above, the following dialog 
appears, used to get project preview

[Note:-STAAD Program can deal with 
single file at a time, so if you try to create a new file while another file is opened ,Staad 
will close OLD file.]

The parts of this dialog box are,

File Name: - Specify the name of the new file (no need to type extension, Staad will do 
that for you) file name is STAAD Pro can take 
long names.

Location: - Specify in which drive you want to 
save, and then specify the folder name (sub 
directory) . To change these settings, Simply 

click the three dots button and follow 
dialogue will appear, choose the folder & click 
ok

Types of structure: - Staad has four type of 
structures, that explained as below,

Space: - Three dimensional framed structures with load applied in any plane (The most 
general).
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Plane: - Two dimensional structures framed in the X-Y plane with loads in the same 
plane.

Note:- based on axis Y plane varying(Local or Global).

Floor-Two (or) Three dimensional structure having no horizontal moment( global x or 
z) of the structure (FX,FY&MZ are restricted at every joint).

Truss-any structure consists of  truss members 
only, which can have only axial member forces 
and no bending in the members.

Length & Force Units:-Choose the respective 
length & Force units i.e.. for example meter & 
KiloNewton.

Note:- we can change the units at any point of 
time inside the program (Staaad internally will 
make the necessary conversion).

When you finished all the options, click 

next button in order to proceed. Th e following 
dialogue box will be displayed.

Add Beam:- Begin building your model by creating new joints and beams using the 
construction grid, drawing tools and spreadsheets. The Add Beam icon supports four 

commands:-

Ø Add Beam for Node to Node
Ø Add Curved Beam
Ø Add Beam Between Mid Points
Ø Add Beam Using Perpendicular Intersection

Add plate:- Begin building your model by creating new joints and 3-noded and 4-
noded plate elements using the construction grid, drawing 
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tools and spreadsheets. The Add Plate icon supports two commands:-

Ø Add Quadrilateral Plate
Ø Add Triangular Plate

Add Solid:- Begin building your model by creating new joints and 8-noded solid/brick 
elements using the construction grid, drawing tools and spreadsheets. The Add Solid 

icon supports five commands:-

Ø Add 8 Noded Solid
Ø Add 7 Noded Solid
Ø Add 8 Noded Solid
Ø Add 6 Noded Solid
Ø Add 5 Noded Solid

Structural Wizard: - Begin building your model by using standard, parametric 
structural templates for trusses, surfaces, bay frames and much more.

Structural Editor: - Begin building your model using STAAD syntax commands (non-
graphical interface) through the STAAD 
editor

Edit Job information:- Provide information 
about the job (i.e. client’s name, job title, 
engineers involved, etc.) before building your 
model.

Here you to choose your option & click finish. 
You will get main screen. The screen part to
be explained below,

1. Graphical Screen:- From This screen user has to create Geometry(or) structure.

2. Page Control:-This tab is used to execute Control & data commands 

Ø These are the tabs that appear at the left of the main window.
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Ø Each Page Control menu has its own 
sub-menu.

Ø Each page control has its own function , 
which will help the user to accomplish 
one of the tasks required.

The Sequence of the page control and the sub page is :

3. Snap/Node Beam:-  Snap/Grid Node | Beam is used 
to specify the grid and snap settings as well as to create 
members and nodes automatically by snapping to grid 
points.

Description

When this option is selected, the Snap Node/Beam dialog 
box appears, as shown below.

4. Tool bar:- STAAD offers a set of “dock able” and 
“floating” toolbars for quick access to frequently used 
commands. By default, the toolbar icons appear at the top 
of the STAAD screen immediately below the menu bar and 
to the left of the Page Control area. his tab is used to 
configure License code to analysis.

5. Menu Bar:- The menu allows the user to perform related 
operations such as creating a new structure model, opening the 
model of an existing structure, saving, printing, viewing 
different files, etc.

Description:-

For example, File menu is shown below in the next two figures. 
The File menu has different menu options depending on 
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whether an input file is currently open or not.  The following figure shows the File 
menu when no input file is open. The menu options are explained 
in the following pages. The following figure shows the File menu 
when an input file is open.

Various methods of constructing the structure      
Following are the various methods to create a structure:

1. Using Structure Wizard.
2. Using the Snap/Grid.
3. Using Editor/Commands.
4. Using Spreadsheet like Excel.
5. Using DXF import.

  Note:
User can use any one of these 5 methods to construct the geometry Alternatively, 

user can’t   accomplish the whole process of creating geometry with any of these 
methods alone; instead, he can combine any of the methods with anyone to 
render the final shape.

Methods 1:    Using Structure Wizard:
              Structure wizard is a library of predefined structure that allows us to create 

our required structure using simple procedures.
Follow these procedures to create a simple structure using wizard:
Ø Start STAAD Pro.
Ø Choose Space give File Name & Location
Ø Units : Meter and Kilo Newton ,Click Next
Ø Click Edit Job Info , Finish
Ø Click Geometry- Run Structure Wizard.

(or)
Ø Start STAAD Pro.
Ø Choose Space give File Name & Location
Ø Units : Meter and Kilo Newton ,Click Next



27

Ø Click Open Structure Wizard , Finish

The following screen will 
appear.

Following are the Model 
Types in wizard:

· Truss Models 
· Frame Models
· Surface/Plate Models
· Solid Models
· Composite Models 
· Import CAD Models
· VBA – Macro Models

Choose Frame Models, and 
following are the structure 

available:
Ø Bay Frame
Ø Grid Frame
Ø Floor Grid
Ø Continuous Beam
Ø Reverse Cylindrical Frame
Ø Circular Frame

Double Click on the Bay Frame icon to 
setup the dimensions. The following dialogue box will be displayed.

Now specify the following inputs.
Ø Length (Length is in X direction)
Ø Height (Height is in  Y direction)
Ø Width (Width is in Z direction)
Ø Number of bays along length.
Ø Number of bays along height
Ø Number of bays along width

        Note:
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1. You should give total Height and the total 
Width of the structure in above dialog 
box.

2. All the number should be positive
3. If you don’t want one of the dimension, 

simply set it to be zero, the structure will 
become two-dimensional.

If the spans are unequal, Click the 
button with the three dots (to the right of 
Number of bays filed) to set the distances of 
each span.

Make sure that the sum of the spans equals the spans equals the total of 
the dimension: otherwise STAAD Pro will produce an error message warning to you, to 
correct this error. Check the figure below.

Click OK to accept 
the number, in the dialog box.

Then click Apply 
on the Select Parameters box. 
The structure will be shown on 
the right.

Finally, in the 
wizard screen select File- Merge model with 
STAAD Pro model. You will see the following 
dialog box:

Confirm Yes. Then the screen will 
appear to ask, whether to move the present 
model to Origin of the main screen.

Click OK. Your model will be 
transferred to main screen.

Note:
If you already have a structure in the main screen, and again want to 

insert another structure from wizard, follow the same above procedure.
Finally, you will be required to choose where to paste the current 

model.
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Click Reference PT.
[Reference point is used to paste a geometry coming from structure Wizard to a 

structure in the STAAD Pro windows.]
v The following screen will appear, asking you to specify the node to handle 

created geometry from, Select one of the Nodes, and click OK.

v The shape of the pointer will change.

v Click on the desired node at the structure in STAAD Pro main window. STAAD
Pro will return back to the old dialogue box with the selected coordinate in X, Y
& Z.

v Click OK to accept the results .STAAD Pro will display a message to inform the 
user that Duplicate nodes ignored, as shown below. This message means, that 
two nodes (one form the Original structure and one from the created geometry 
Click OK.

v The same issue applies to the beams; a new message will appear telling,
Duplicate beams ignored as shown in the dialogue box shown below. Click OK. 
Finally the geometry is pasted in the right place.

       Likewise, now we shall create other 
structure in frame models.

Frame models->Grid Frame:
Grid Frame is just like Bay Frame 

with one exception. It creates ground 
beams in the X-Z plane of the difference.
All other procedures are same. Following 
diagram shows the difference.

Frame Models -> Floor Grid :
Floor Grid is a two –dimensional structure 

in the X-Z plane only. The purpose of floor grid 
is to create a mesh o beams in the X and Z 
direction.

Double –Click on the Floor Grid icon, the
following dialogue box will be shown.

Frame Models -> Continuous Beam:
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Continuous Beam is one dimensional structure in the X direction only.
Double click continuous Beam icon, the following dialogue box will be shown. 

Note that Height (Y Axis) and Width (Z Axis) are not available for editing.
Note:- All other frame models are dealt in advanced chapters.

Truss models:
Choose Truss Models under model types and following are the structures 

available:  
                                                                   

Double click on any icons, you will get same 
dialogue box for all six shapes , as shown in the 
dialogue box below,

As you can see from the dialogue 
box, you can change the following 
parameters,

v Total  Length (in X direction)
v Total Height (in Y direction) 
v Total WIDTH (IN Z direction), for 3d trusses 

only
§ Note:-If want 2D set it to )

v Number of bays in along length 
(Note:-the parameter will decide the shape of the 

truss)
v Number of bays along width.

(Note:-set it to zero if you want 2D 
truss) 
The rest of the procedure is same as the 
Frame Models.

Surface /Plate Models:
Choose Surface/Plate Models under 
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model types  and following are the Structures Available:
To create 3-Noded or 4-Noded plates , double click on Quad Plate , you will see 

the following dialog box ,
From the element type (Upper right portion of the  dialogue box) specify if you 

want triangle shape (3-noded) or Quadrilateral shape (4-noded).
You have 4 corners to specify A, B , C & D which they will be the corner of 

desired plate. The XYZ here doesn’t mean the real XYZ of the space we are using in 
Staad Pro window , but rather XYZ of the structure wizard. This point can attach to any 
other point in the Staad Pro Window. Also the use of the XYZ is a very good way to tell 
Structure Wizard in which plane you will create your plate. 

As an example for the last one ,check the following  4 corners :
A=0, 0, 0;
B=10, 0, 0;
C=10, 0, 10;
D=0, 0, 10
The result will show as the shape below:

As you can see the Y co-ordinate is always 0, hence the plate is in the X-Z plane , this is 
a good geometry for slab.
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While giving the coordinate of the 3 or 4 nodes, you must be consistent, either rotate 
clockwise (CW) or counter clock wise (CCW).
In the Bias and Division parts, specify the number of diversions each side of the plate 
will be divided to. By default Bias=1, means the divisions are equally spaced. Dividing a 
plate we will more than one plate (one plate here means one entity). Example would be 
if you have a plate 10x10 m plate divided by 10 divisions from each side, therefore the 
total number of smaller plates will be 10 plates in each of 1mx 1m .

Click Apply. Then follow the same procedure as seen previous to transfer model 
to main screen.

Note:-
v All other model types like solid, Composite models etc are default in advanced 

chapters.
v Click on the following toolbar buttons in Structure Wizard shown below & 

practice with the following views ant rotations after creating the Structures.
Methods 2:    Using Snap/Grid:
              Snap/Grid is a method of creating structure using snap/grids that allows us 

to create our required structure using simple procedures.
Follow these procedures to create a simple structure using wizard:
Ø Start STAAD Pro.
Ø Choose Space give File Name & 

Location
Ø Units : Meter and Kilo Newton ,Click 

Next
Ø Click Add Beam(or)Add Plate(or)Add 

Solid , Finish
Staad main screen will appear (Add 

Beam/Add Plate/Add Solid is explained in the 
next page).Follow any one of the below methods to 
have the following screen:

Automatically snap/grid enable to make by 
default type (beam/plate/solid).By default 10x10 
grid is appears in the XY Plane. Because 10x10 grid not enough to complete a structure, 
we have to customize the Grid by the following ways,
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Ø If you want to modify the default, click edit button or to create new grid 
click Create button .he Floor Grid icon, the following dialogue box will be 
shown.

Here there are three type of Grids settings available .They are
Ø Linear grid(For Linear Structures)
Ø Radial grid(For Curve Structures)
Ø Irregular grid(For Irregular Structures)

Linear Grid 
Follow the steps below to customize the linear Grid
Ø Decide the plane that you want to work (XY, YZ or ZX plane).
Ø Specify Angle of Plane (Leave it 0 for now) & Pick angle plane(X-X,Y-Y 

or Z-Z plane).
Ø Specify Origin point (Preferable to leave it at 0, 0, 0).
Ø Specify Left & Right Counts in the construction line area. 
Ø Specify the spacing & skew in the construction lines 

After completing the above steps click OK to close.
Radial Grid 

Follow the steps below to customize the Radial Grid
Ø Decide the plane that you want to work (XY, YZ or ZX plane).
Ø Specify Angle of Plane (Leave it 0 for now) & Pick angle plane(X-X, Y-Y 

or Z-Z plane).
Ø Specify Origin point (Preferable to leave it at 0, 0, 0).
Ø Specify Start Angle, Sweep & Bays Counts in the construction line area. 
Ø Specify the Radis1,Radius 2 & Bays in the construction lines 

After completing the above steps click OK to close.
Irregular Grid 

Follow the steps below to customize the Irregular Grid
Ø Specify Origin point (Preferable to leave it at 0, 0, 0).
Ø Specify Distance offset in arbitrary plane as xyz co-ordinate values. 
Ø Decide the plane that you want to work (XY, YZ or ZX plane).
Ø Specify Angle of Plane (Leave it 0 for now) & Pick angle plane(X-X, Y-Y or 

Z-Z plane).
Ø Specify the Relative grid line distance in the X & Y axis.
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After completing the above steps click OK to close.
After completing any of the above choose grid line & make Geometry by 

using following steps,
Ø Select from the page control/Geometry tab (or)
Ø Select from the menus Geometry/Snap Grid Node then

Beam/Plate/Solid
Ø From the Geometry toolbar or Geometry menu, select one of two

available Snap node/Beam or Snap Node/Plate.
Adding Beams

Make Sure that SNAP NODE/BEAM is on.
To start drafting Beams, go to start NODE Coordinate and click , a node will be 

inserted here , and click , a second new mode will be added and according a new beam 
will be created. Keep on doing this until you are done, the click close button

Note:-Once you starting clicking nodes , controlling point will restrict to start 
your next beam from the last node reached. In order avoid this hold Control Key and 
click on the desired node other than the last node anf you can start next beam from that 
Node.
Adding Plates

Make sure that Snap Nose /Plate is On.
To start drafting Plates, Go to the Start Node Coordinate and click, a node is 

inserted here. Repeat this process for four points, a plate will be added .Then you are 
done click close.
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Note:- Once you finish the first plate , the 
controlling point will restrict you to start next plate 
from the last node reached. To avoid this , hold the 
Ctrl key and click on the coordinate desired other 
than the last node and you can start your next plate 
from that node.
Fill Plates

To view your plates for the procedure 
below,

Ø In the Staad Pro Window, right click 
anywhere, menu screen will appear,
select from it Structure Diagrams. The following dialogue box will appear :

Ø Under View, Click Fill Plates/Solids/Surfaces On, click Sort Nodes On.

Methods 3:    Using Editor/Commands:
              This Method is used to create Structure 

by writing Program Codes using Editor Window. 
The advantages of Editor are as follows,

Ø Knowledge of the STAAD language can 
be very useful in utilizing the large 
number of facilities available in the 
program.

Ø The user can easily make changes to the 
input data if he/she has a good 
understanding of the command language 
and syntax of the input. 

Ø The input file represents the user's 
thought about what he/she wants to 
analyze or design. With the knowledge 
of the STAAD command language, the 
user or any other person can verify the 
accuracy of the work.

The commands used in the input file are 
explained in Section 5 of the STAAD Technical 
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Reference Manual. Users are urged to refer to that manual for a better understanding of 
the language.

Follow these procedures to create a simple structure using wizard:
Ø Start STAAD Pro.
Ø Choose Space give File Name & Location
Ø Units : Meter and Kilo Newton

,Click Next
Ø Click Open Staad Editor , Finish

[Note:-Alternatively, any 
standard text editor such as Notepad or 
WordPad may also be used to create the 
command file. However, the STAAD Pro 
command file editor offers the advantage 
of syntax checking as we type the 
commands. The STAAD Pro keywords, 
numeric data, comments, etc. are displayed in distinct colors in the STAAD Pro editor.]

Some of the basic pasic Programming Concept to be explained below,

NODES

To create we have to use Joint Coordinates Specification method

These commands allow the user to specify and generate the coordinates of the 
JOINTs of the structure. The JOINT COORDINATES command initiates the 
specification of the coordinates. The General format for Joint Co-ordinate is explained 
below:

JOINT COORDINATES (CYLINDRICAL (REVERSE)) (NOCHECK) band-spec

i1, x1, y1, z1, (i2, x2, y2, z2, i3 )

Description

The command 

Ø The command JOINT COORDINATES specifies a Cartesian coordinate system. 
Joints are defined using the global X, Y and Z coordinates. 
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Ø The command JOINT COORDINATES CYLINDRICAL specifies a Cylindrical 
Coordinate System. Joints are defined using the r, q and z coordinates. 

Ø JOINT COORDINATES CYLINDRICAL REVERSE specifies a Reverse 
Cylindrical Coordinate system (see Figure 1.4). Joints are defined using the r, y 
and q coordinates. 

*  i1 = the joint number for which the coordinates are provided. Any integer number 
(maximum 6 digits) within the limit is permitted.

X1, y1 and z1 =  X, Y & Z (R, & Z for cylindrical or R, Y & for cylindrical reverse) 
coordinates of the joint.

For PLANE analyses z1 is an optional data item when defining input for individual 
joints. Z1 is always required for joint generation. The following are used only if joints 
are to be generated.

*  i2 = the second joint number to 
which the joint coordinates are 
generated.

X2, y2, and z2 = X, Y & Z (R, & Z for 
cylindrical or R, Y & for cylindrical 
reverse) coordinates of the joint i2.

Example 1

To create a room of size 20 feet 
length & 15 feet width, Open the 
staad Editor same as above & Enter 
following codes,

STAAD SPACE

INPUT WIDTH 79

uni ft kn
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Joint coordinates

1 0 0 0 

2 10 0 0

3 10 0 10

4 0 0 10

5 0 10 0 

6 10 10 0

7 10 10 10

8 0 0 10

FINISH 

Close & save the editor, The Result Screen is shown above.

(Note:- Use SHIFT+K to view nodes & SHIFT +N to node numbers)

To create multi-storey structures, user cannot be able to all calculate by using method. 
To avoid this, we have gone for REPEAT & REPEAT ALL functions

Ø The REPEAT command causes the previous line of input to be repeated ‘n’ 
number of times with specified coordinate increments. 

Ø The REPEAT ALL command functions similar to the REPEAT command except 
that it repeats all previously specified input back to the most recent REPEAT 
ALL command, or all joint data if no previous REPEAT ALL command has been 
given. Note: Use “REPEAT ALL 0” to start a section of data to be repeated if 
necessary. (When using the REPEAT and REPEAT ALL commands, joint 
numbering must be consecutive and should begin with 1.)

Ø To create a room of size 20 feet length & 15 feet width, Open the staad Editor 
same as above & Enter following codes,
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JOINT COORDINATES (CYLINDRICAL (REVERSE)) (NOCHECK) band-
spec

i1, x1, y1, z1, (i2, x2, y2, z2, i3 )

REPEAT  n, xi1, yi1, zi1, (xi2, yi2, zi2... xin, yin, zin)

REPEAT ALL  n, xi1, yi1, zi1, (xi2, yi2, zi2,..., xin, yin, zin)

n is limited to 150

STAAD SPACE

INPUT WIDTH 79

uni ft kn

Joint coordinates

1 0 0 0 7 60 0 0 

FINISH 

Note:-Here Staad takes 1 0 0 0 as staring node 7 60 0 0 as ending node. That means 
Staad Calculates Difference between Nodes & calculates Axis Difference & Inserts all 
point in between 1 & 7.Instand of that ,if you give 1 0 0 0 ; 7 60 0 0 that means only 2 
nodes staring Ending. 

Now Single column span is created, to copy in 
to floor level we have to use repeat function. 
the syntax is 

Repeat 5 0 0 10

Add the above syntax after 1 0 0 0 7 60 0 0 
Above command copy the last step 5 time in 
the z axis. The output is shown above.
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NOCHECK=     Do not perform check for multiple structures or orphan joints.
JTORIG   xOrigin   yOrigin   zOrigin

band-spec = (NOREDUCE BAND)

The JTORIG command should be entered on a separate command line. Basically after 
the joint coordinates are entered or generated, then the xOrigin, yOrigin, and zOrigin 
values are added to the coordinates. For example a cylinder could be generated about 
the Y axis then moved by this command to its proper place. To create multiple offset 
structural parts, enter additional JOINT COORDINATES commands, each one 
followed by its JTORIG command. An example showing the use of this command is 
provided later in this section.

The multiple JOINT COORDINATES command concept allows UNIT changes and 
PERFORM ROTATION commands in between; such that these commands would 
apply to a selected portion of the joints. However, the PERFORM ROTATION 
command applies to all prior defined joints, not just those in the previous JOINT 
COORDINATE command.

NOREDUCE BAND causes the program to execute without performing a bandwidth 
reduction. 

Methods 4:    Using Spread Sheet like Excel:

In This Method you to type each node joint or node coordinate in the spread sheet, 
which is given in STAAD to construct the required Structure.

Ø Start Space
Ø Choose Space, give File name & location.
Ø Units Meter and Kilo Newton, Click next 

Select Geometry/Nodes from the menu, then type all joint coordinates, side by side 
node is seen on the main screen. After constructing nodes, Right click on the screen 
and choose Add Beam or from Geometry menu select Add Beam/Add Beam from 
point to Point.
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Hint:-

If you want to connect columns & beams quickly first select all nodes, then go 
to Geometry/Connect Beams along X/Z axis for beams & Geometry/Connect along Y 
Axis for Columns.

You can also add Plates like this from Geometry menu.

Methods 5:  Using DXF Import:

You should know AutoCAD somewhat, before using this method. Following 
are the steps to create a structure using this method,

   Procedure-A

Ø Start AutoCAD 
Ø Draw your structure(2d or 3d)
Ø Close & save file in the DXF format.

Note:- AutoCAD default Format is 
Dwg, You have to change file type to 
DXF from the Type dialogue.

To import the DXF file saved above, you to follow 
any one of the method explained below,

a) From Structure Wizard,
b) From File Import

Procedure-B

a) From Structure Wizard:-

Ø From the model Type select Import Cad 
Models.

Ø Double click on the scan DXF icon, a 
dialogue box will appear to make you select file name.
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Ø The DXF will be scanned and opened.

b) From Structure Wizard:-

Ø Start Staad Pro.
Ø Start New Project using above Procedure.
Ø After Getting new project. 
Ø From File Menu Select File/Import.

Staad asks now about the type to be imported:

v Select 3D DXF and import. STAAD Pro will ask the location of your DXF file.
v Select the file, and Click Open. The following dialogue box will appear.
v Now Select one of the three choices, and click ok:

· No Change:-The XYZ orientation of STAAD matches the XYZ in 
AutoCAD.

· Y up:-You are telling STAAD to consider Y is up in Staad, and hence to 
convert Y in Autocad Accordingly. (This is the right choice in almost all 
of the cases.

· Z up:- You are telling Staad to 
consider Z is up in Staad, and hence 
to convert Z in AutoCAD
accordingly.

v The Following of the dialogue will appear:-
v Select the Proper Length & Force Unit and 

click OK, the structure will transferred.

Note:-

1. In AutoCAD, use always Line, in drafting Beams & Columns
2. Staad will consider one line as equal to one Beam or Column, hence long 

line covering more than one node Will be considered as one object. 
According cut your lines to be small and connecting two Nodes only 

3. Use the latest AutoCAD version with the latest Staad Versions.
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Viewing:
Various Viewing tools can be explained below,

View from +Z, you consider it the Front View

View from -Z, you consider it the Back View

View from +X, you consider it the Left View
View from -X, you consider it the Right View
View from +Y, you consider it the Top View
View from -Y, you consider it the Bottom View
Isometric -it the Isometric View

Rotations
Rotate up & Down, Rotating around the X axis 

Rotate left & Right, Rotating around the Y axis

Rotate Left & Spin Right, Rotating around the Z axis

You can use the arrows in your key board also.

Use:-

Ø Right arrow and Left Arrow to rotate around Y axis.
Ø Up Arrow and down arrow to rotate around X axis.

Selecting:

Various Selecting tools can be explained below,

Nodes Cursor, to select nodes.

Beams Cursor, to select Beams.

Plates Cursor, to select plates.

Surface Cursor, to select Surfaces.

Solid Cursor, to select Solid.

Single Selection:
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Ø Click ON the desired node, Beam, (or) Plate, it will be highlighted by 
running in to red.

Ø From the Data/Area, click on the numbers of the node, Beam o Plate , it 
will highlighted. Check the picture below,

Multiple Selections:

Ø Select any Node, Beam, or Plate 
First, then hold down the ctrl key, 
and click other nodes, Beams and 
Plates. 

Ø From the Data/Area, Click on the 
number of the Node, Beam, or 
Plate. It will be highlighted. Then 
hold Ctrl key, and click on other numbers; it will highlighted as Well.

Ø Make a window around the needed nodes; Beams, (or) Plates by clicking 
in any empty place of the Window, and Holding down the left Button, 
moving to the other corner and releasing the button, whatever inside the 
window will be selected based on cursor we are using.\



45

Ø joint coordinates command. It is useful in instances such as when the 
centre of cylinder is not at (0, 0, 0) 
but at a different point in space.

Select While Viewing 3D Geometry:

Using both Viewing commands and 
Selecting methods leads to effectively select 
multiple Nodes, beams, or Plates, in 3D 
Geometry. Looking at a 3D model from different 
viewing points will enable the user to select 
Nodes/Beams or Plates in the plane shown and any things behind it.

Figure 13d Isometric View Figure 2 View From +Z

Now click on the Beams as shown,
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Using Labels:

In the STAAD Pro window, Right click on any place, a menu will appear, 
select from it labels, a large dialogue box will appear as below,

v Turn on Node Numbers & Node Points, Beam Numbers, Plate 
Numbers to see element nos.
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CHAPTER – IV
Other Functions useful For Construction of Geometry

This Chapter covers:
Ø Inserting nodes
Ø Placing plates, surface & Solids
Ø Translational Repeat 
Ø Circular Repeat
Ø Mirror, Rotate, move
Ø Adding Beams (connecting & intersecting) 
Ø Cut section 
Ø Renumber 
Ø Delete, undo/redo, dimension etc 
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INTRODUCTION
We have discussed four methods in the previous chapter that are used to create the 

basic geometry. However, it alone cannot fulfill the creation of some complex 
requirements of any structural engineer.

So when you complete this chapter, you will be finishing all the requirements to 
construct any type of Structure.

In this module, we will discuss essential functions, which will enable the user to 
complete any unusual requirements in the building up the geometry.

All of the functions to be discussed require to Inserting Nodes, Plates, Surfaces & 
Solids.
Inserting Plates

This option allows you to add Triangular or Quadrilateral plate elements by 
connecting existing nodes.

Description
To create new elements, simply click on the existing nodes in the right sequence. A 

rubber-banded area shows the boundary of the plate being generated. Methods to 
create as follows,

v To add Quadrilateral plate, select Quad from Geometry/Add Plate/Quad menu. 

F
or triangular plates, select Geometry/Add Plate/Triangle from the sub-menu. 
The cursor changes to Quad Plate or Triangular Plate as shown 
below.

v From tool bar click, Plate icon appears, this 4 nodded plates. To 
get more options, hold down the left mouse button 
when clicking on the button. Icons that have this
property are identified with a black triangle in their 
lower right corner:-
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Set New Plate Attribute

Similar to the “Set New Member Attribute” command introduced in STAAD
Pro 2004, a new command, in which the user can define the 
property, material and releases to each new plate element as it 
is created, has been introduced. 

In order to define the attributes for a plate element 
before they are created, go to Geometry | Add Plate | Set 
New Plate Attributes from the main menu. 

A dialog box will prompt for various attributes of the 
plate to be pre-defined. A summary of the specific attributes 
are defined in the table below.

Multiple properties, releases and 
materials can be created and saved for 
future use. To choose from various pre-
defined types, simply select the 
appropriate definition using the “Select 
Property”, “Select Material” or the 
“Plate Release” drop-down boxes. 

For the program to recognize the 
pre-defined attributes, the “Assign these attributes while creating new plates” check 
box must be checked. Any new plate element created from here on (whether created 
individually, through a mesh or Structure Wizard) will now possess these attributes. 

Surfaces:-
For any surface type of structural component, modeling requires breaking it down 

into a series of plate elements for analysis purposes. This is what is known in stress 
analysis parlance as meshing. When a user chooses to model the surface component 
using plate elements, he/she is taking on the responsibility of meshing. Thus, what the 
program sees is a series of elements. It is the user's responsibility to ensure that meshing 
is done properly. 
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With the new Surface type of entity, the burden of meshing is shifted from the user 
to the program to some degree. The entire wall or slab is hence represented by just a 
few "Surface" entities, instead of hundreds of elements. When the program goes 
through the analysis phase, it will subdivide the surface into elements by itself. The user 
does not have to instruct the program in what manner to carry out the meshing.
Inserting Surfaces

This option allows us to add Surface elements by connecting existing nodes. 
Description
When we select this option, the cursor changes to a Surface cursor as shown 

below.To create new solid elements, simply click on the existing nodes in the right 
sequence. A rubber-banded area shows the boundary of the element being generated.

To create new elements, simply click on the existing 
nodes in the right sequence. A rubber-banded area shows 
the boundary of the plate being generated. Methods to 
create as follows,

v To add Quadrilateral plate, select Quad 
from Geometry/Add Surface menu..
v From tool bar click, Add Surface icon appears, this creates 5 nodded 
Surfaces.

Inserting Solids
This option allows us to add solid elements by connecting existing nodes. 
Description
When we select this option, the cursor changes to a Solid cursor as 

shown below.
To create new solid elements, simply click on the existing nodes in the 

right sequence. A rubber-banded area shows the boundary of the element being 
generated.

To create new elements, simply click on the existing nodes in the right sequence. A 
rubber-banded area shows the boundary of the plate being 
generated. Methods to create as follows,

v To add Quadrilateral plate, select Quad from 
Geometry/Add Solid menu..
v      From tool bar click, Add Solid icon appears, 
this creates 8 nodded Solids. To get more options, hold down the left mouse 


